
LECTURER LAB PLAN –“ COMPUTER  APPLICATION “

	Programme- Diploma Engineering 
Semester-1st& 2nd (Common) 
Course Code-Th 1b (Practical)
Periods/week-04 periods per week
Duration of period-55mins
	
Lab taken by   : 
Mr. Sabyasachi Sarangi
	
Lab Class No. 1
Week No. 

	Course Name : Computer Application Practical                  


	Topic- BASIC COMPUTER OPERTION 


	Essential Prerequisites : One computer set 


	Intended Learning Outcome expected- After the completion of this topic, students  will be able to
· Identify all the components of a PCs 
· Switch on 
· Shut down 
· Restart 


[image: The Computer System]Identify all the different components of a PCs 



	Problems / questions  related to the above class         :     5 Minutes

	Attendance      :  5 Minutes 

	Reference        :  

	Lab taken by   :  






	Programme- Diploma Engineering 
Semester-1st& 2nd (Common) 
Course Code-Th 1b (Practical)
Periods/week-04 periods per week
Duration of period-55mins

	
Lab taken by   : 
Mr. Sabyasachi Sarangi
	
Lab Class No. 2
Week No.

	Course Name : Computer Application Practical


	Topic- BASIC COMPUTER OPERTION 


	Essential Prerequisites : One computer set 


	Intended Learning Outcome expected- After the completion of this topic, students  will be able to
· Switch on 
· Shut down 
· Restart 



 
Swich ON  from main power Supply 
[image: ]
· To start a Computer 
· Boot process how it works 
· To properly connect with all the devices  








	Problems / questions  related to the above class         :     5 Minutes

	Attendance      :  5 Minutes 

	Reference        :  

	Lab taken by   : 







	Programme- Diploma Engineering 
Semester-1st& 2nd (Common) 
Course Code-Th 1b (Practical)
Periods/week-04 periods per week
Duration of period-55mins

	
Lab taken by   : 
Mr. Sabyasachi Sarangi
	
Lab Class No. 3
Week No.

	Course Name : Computer Application Practical


	Topic- BASIC COMPUTER OPERTION


	Essential Prerequisites : One computer set 


	Intended Learning Outcome expected- After the completion of this topic, students  will be able to
· Switch on 
· Shut down 
· Restart
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	Problems / questions  related to the above class         :     5 Minutes

	Attendance      :  5 Minutes 

	Reference        :  

	Lab taken by   : 







	Programme- Diploma Engineering 
Semester-1st& 2nd (Common) 
Course Code-Th 1b (Practical)
Periods/week-04 periods per week
Duration of period-55mins
	
Lab taken by   : 
Mr. Sabyasachi Sarangi
	
Lab Class No. 4
Week No.

	Course Name : Computer Application Practical


	Topic- BASIC COMPUTER OPERTION

	Essential Prerequisites : One computer set 


	Intended Learning Outcome expected- After the completion of this topic, students  will be able to
· Shut down 
· Restart 
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BOOTING PROCESS

The boot process is performed under the guidance of the BIOS. The BIOS contains the instructions needed to verify, test, and start the PC—in other words, boot the computer. When the computer boots up, the BIOS is behind the scenes causing and managing the actions that are taking place. The PC’s hardware cannot perform independent actions. It must have instructions to do anything at all. These instructions are in the form of the PC’s software, which are blocks of instructions that guide the hardware to perform specific activities.
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	Problems / questions  related to the above class         :     5 Minutes

	Attendance      :  5 Minutes 

	Reference        :  

	Lab taken by   : 









	Programme- Diploma Engineering 
Semester-1st& 2nd (Common) 
Course Code-Th 1b (Practical)
Periods/week-04 periods per week
Duration of period-55mins
	
Lab taken by   : 
Mr. Sabyasachi Sarangi
	
Lab Class No. 5
Week No.

	Course Name : Computer Application Practical


	Topic-  Power Supply Unit

	Essential Prerequisites : One computer set 
	Intended Learning Outcome expected- After the completion of this topic, students  will be able to learn about power supply unit





A power supply unit (PSU) converts mains AC to low-voltage regulated DC power for the internal components of a computer. Modern personal computers universally use switched-mode power supplies. Some power supplies have a manual switch for selecting input voltage, while others automatically adapt to the mains voltage.


[image: ]


	Problems / questions  related to the above class         :     5 Minutes

	Attendance      :  5 Minutes 

	Reference        :  

	Lab taken by   : 





	Programme- Diploma Engineering 
Semester-1st& 2nd (Common) 
Course Code-Th 1b (Practical)
Periods/week-04 periods per week
Duration of period-55mins
	
Lab taken by   : 
Mr. Sabyasachi Sarangi
	
Lab Class No. 6
Week No.

	Course Name : Computer Application Practical


	Topic- Motherboard

	Essential Prerequisites : One computer set 


	Intended Learning Outcome expected- After the completion of this topic, students  will be able to
· Identify the Motherboard


Motherboard
The motherboard serves as a single platform to connect all of the parts of a computer together. It connects the CPU, memory, hard drives, optical drives, video card, sound card, and other ports and expansion cards directly or via cables. It can be considered as the backbone of a computer.

[image: ]

Features of Motherboard
A motherboard comes with following features −
· Motherboard varies greatly in supporting various types of components.
· Motherboard supports a single type of CPU and few types of memories.
· Video cards, hard disks, sound cards have to be compatible with the motherboard to function properly.
· Motherboards, cases, and power supplies must be compatible to work properly together.



	Problems / questions  related to the above class         :     5 Minutes

	Attendance      :  5 Minutes 

	Reference        :  

	Lab taken by   : 




	Programme- Diploma Engineering 
Semester-1st& 2nd (Common) 
Course Code-Th 1b (Practical)
Periods/week-04 periods per week
Duration of period-55mins

	
Lab taken by   : 
Mr. Sabyasachi Sarangi
	
Lab Class No. 7
Week No.

	Course Name : Computer Application Practical


	Topic- Motherboard Components and Their Functions


	Essential Prerequisites : One computer set 


	Intended Learning Outcome expected- After the completion of this topic, students  will be able to
Learn  Motherboard Components and Their Functions




[image: ]
Motherboard Components and Their Functions
· CPU (Central Processing Unit) chip.

· RAM (Random Access Memory) slots.

· Southbridge/northbridge.

· BIOS (Basic Input/Output System)

· I/O port.

· USB (Universal Serial Bus)

· CPU slot.

· PCI (Peripheral Component Interconnect) slot.





	Problems / questions  related to the above class         :     5 Minutes

	Attendance      :  5 Minutes 

	Reference        :  

	Lab taken by   : 







	Programme- Diploma Engineering 
Semester-1st& 2nd (Common) 
Course Code-Th 1b (Practical)
Periods/week-04 periods per week
Duration of period-55mins

	
Lab taken by   : 
Mr. Sabyasachi Sarangi
	
Lab Class No. 8
Week No.

	Course Name : Computer Application Practical


	Topic- Identification of  different ports of  Computer.


	Essential Prerequisites :  CPU

	Intended Learning Outcome expected- After the completion of this topic, students  will be able to
· Identification of  different ports of  Computer





Brief introduction to different types of ports along with their applications.
· [image: ]PS/2.

· Serial Port. DB-25. ...

· Parallel Port or Centronics 36 Pin Port.

· Audio Ports. Surround Sound Connectors or 3.5 mm TRS Connector.

· S/PDIF / TOSLINK.

· Video Ports. VGA Port.

· Digital Video Interface (DVI) Mini-DVI. ...

· Display Port.



	Problems / questions  related to the above class         :     5 Minutes

	Attendance      :  5 Minutes 

	Reference        :  

	Lab taken by   : 





	Programme- Diploma Engineering 
Semester-1st& 2nd (Common) 
Course Code-Th 1b (Practical)
Periods/week-04 periods per week
Duration of period-55mins

	
Lab taken by   : 
Mr. Sabyasachi Sarangi
	
Lab Class No. 9
Week No.

	Course Name : Computer Application Practical


	Topic- Types of connector


	Essential Prerequisites : 


	Intended Learning Outcome expected- After the completion of this topic, students  will be able to understand the varieties of connector and their uses 
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Types of Connectors

· AUDIO & VIDEO CONNECTORS.

· AUTOMOTIVE CONNECTORS.

· CIRCULAR CONNECTORS.

· CONNECTOR BACKSHELLS & ADAPTERS.

· D-SHAPED CONNECTORS.

· DOCK CONNECTORS & GUIDE HARDWARE.

· FIBER OPTIC CONNECTORS.

· LIGHTING CONNECTORS.





	Problems / questions  related to the above class         :     5 Minutes

	Attendance      :  5 Minutes 

	Reference        :  

	Lab taken by   : 







	Programme- Diploma Engineering 
Semester-1st& 2nd (Common) 
Course Code-Th 1b (Practical)
Periods/week-04 periods per week
Duration of period-55mins
	
Lab taken by   : 
Mr. Sabyasachi Sarangi
	
Lab Class No. 10
Week No.

	Course Name : Computer Application Practical


	Topic- Connectors and  their purposes .

	Essential Prerequisites : 

	Intended Learning Outcome expected- After the completion of this topic, students  will be able to
Learn about Connectors and  their purposes



Types of Connectors and Applications
Every Connector has a male-end called plugs, and a female-end called jacks. There is a vast amount of individual electrical Connector types that can be differentiated in several ways, and now we will see the classification of Connectors based on its applications.
· Keyed Connectors: These Connectors can be joined together when they are adequately aligned together. This property helps avoid accidental damage to the terminal pins of the Connectors.
· ESD Shielded Connectors: The ESD Connectors have protection from electrostatic discharge, which can damage the circuit of its components.
· Locked Connectors: These Connectors have an inbuilt locking mechanism which helps to keep the connection in place.
· EMI Filtering: These Connectors have an additional feature that is mounted on the housing. This feature helps the Connector to shield itself from electromagnetic interference.
· Water-Resistant Connectors: water can damage Connectors very easily. Hence these Connectors are made water-resistant.
· Hermetically Sealed Connectors: These Connectors can be used underwater. It will not get damaged by the water pressure.
· Moisture/Oil Resistant Connectors: These Connectors are specifically made to protect them from oil and moisture.

Classification of Connectors Based on Connector Level
· Box to Box or Input/Output Connectors: The input/output (I/O) Connectors are for attaching external devices, such as printers, keyboards, and displays, to the server.
· Wire to Board Connectors: These types of Connectors are used to connect wires to a printed circuit board to enable connectivity between circuits.
· Chip to Package Connectors: A chip to package Connector comprises a conductive member electrically coupled to the contacts and the remote device; wherein the contacts are arranged to be electrically and mechanically coupled to a circuit board.
· Board to Board Connectors: This type of device is engineered to provide signal connections between two printed circuit boards (PCBs).



Classification of Connectors Based on Connector Function
· Terminal Block: These Connectors terminate a single wire and connect it to a circuit. We use terminal block Connectors to connect wires from the same circuit without cutting the wires.  Terminal block connection is further categorized as-
1. Barrier Strips- These are the interConnectors that contain metal strips, and screws or Connectors for easy connection and termination of wires.
2. Printed Circuit Board Terminal Blocks (PCB)- They are directly embedded into the circuit board and are commonly used for power, data, and signal connections across industries.
3. Multiple Terminal Connectors (MTC)- These blocks are used to connect multiple wires to a single terminal block, thereby reducing the reliability issues faced when multiple wires are connected in a single clamp.
4. Pluggable Terminal Blocks- They have a cable opening to allow the connection of cables along with a plug output that allows easy connection to a socket. They are useful in hot swapping situations. 
· Binding Post: The binding post Connectors are widely used in test fixtures for wire termination. You can find them in loudspeakers and audio amplifiers.
· Blade: This Connector uses conductive blades that are flat and connect single wires to the blade receptacles. These are attached to the connecting wires and are generally used in speakers and thermostats.
· Ring and Spade: In this, the connection is embedded between a threaded post and a screw. It allows making easy connections that can be removed effortlessly as the lock is partially closed. 
· Plug and Socket: They are suitable for use in control circuits. They provide connections between control circuitry and components. Plug and Socket Connectors are used in appliances to handle video and audio such as USB, network computing, HDMI, etc. 
· Rack and Panel: These Connectors are specially designed to connect any device to an equipment rack. They are designed for military and commercial performance and are manufactured to the highest quality and durability standards. This connects electronic pieces that can be removed with stationary or immovable parts of equipment. It is further classified into three- rack and panel, cable to cable, and cable to panel. They are used home theatre systems, printers, modems, etc. 





	Problems / questions  related to the above class         :     5 Minutes

	Attendance      :  5 Minutes 

	Reference        :  

	Lab taken by   : 







	Programme- Diploma Engineering 
Semester-1st& 2nd (Common) 
Course Code-Th 1b (Practical)
Periods/week-04 periods per week
Duration of period-55mins
	
Lab taken by   : 
Mr. Sabyasachi Sarangi
	
Lab Class No. 11
Week No.

	Course Name : Computer Application Practical


	Topic- Cooling System in Computer

	Essential Prerequisites : 

	Intended Learning Outcome expected- After the completion of this topic, students  will be able to
Learn about Cooling System in Computer



[image: ]Cooling may be designed to reduce the ambient temperature within the case of a computer, such as by exhausting hot air, or to cool a single component or small area (spot cooling). Components commonly individually cooled include the CPU, graphics processing unit (GPU) and the northbridge.
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	Problems / questions  related to the above class         :     5 Minutes

	Attendance      :  5 Minutes 

	Reference        :  

	Lab taken by   : 






	Programme- Diploma Engineering 
Semester-1st& 2nd (Common) 
Course Code-Th 1b (Practical)
Periods/week-04 periods per week
Duration of period-55mins
	
Lab taken by   : 
Mr. Sabyasachi Sarangi
	
Lab Class No. 12
Week No.

	Course Name : Computer Application Practical


	Topic- RAM & ROM

	Essential Prerequisites : One computer set


	Intended Learning Outcome expected- After the completion of this topic, students  will be able to learn about Different activities of RAM & ROM


[image: ]
Random Access Memory (RAM) and Read Only Memory (ROM)
Memory is the most essential element of a computing system because without it computer can’t perform simple tasks. Computer memory is of two basic types – Primary memory(RAM and ROM) and Secondary memory (hard drive, CD, etc). Random Access Memory (RAM) is primary-volatile memory and Read-Only Memory (ROM) is primary-non-volatile memory. 
 [image: ]

	Problems / questions  related to the above class         :     5 Minutes

	Attendance      :  5 Minutes 

	Reference        :  

	Lab taken by   : 






	Programme- Diploma Engineering 
Semester-1st& 2nd (Common) 
Course Code-Th 1b (Practical)
Periods/week-04 periods per week
Duration of period-55mins

	
Lab taken by   : 
Mr. Sabyasachi Sarangi
	
Lab Class No. 13
Week No.

	Course Name : Computer Application Practical


	Topic- ROM

	Essential Prerequisites : 


	Intended Learning Outcome expected- After the completion of this topic, students  will be able to learn about ROM



Read-Only Memory (ROM)  
· [image: ]Stores crucial information essential to operate the system, like the program essential to boot the computer.
· It is not volatile.
· Always retains its data.
· Used in embedded systems or where the programming needs no change.
· Used in calculators and peripheral devices.
· ROM is further classified into four types- MROM, PROM, EPROM, and EEPROM. 
Types of Read-Only Memory (ROM) 
· PROM (Programmable read-only memory) – It can be programmed by the user. Once programmed, the data and instructions in it cannot be changed. 
· EPROM (Erasable Programmable read-only memory) – It can be reprogrammed. To erase data from it, expose it to ultraviolet light. To reprogram it, erase all the previous data. 
· EEPROM (Electrically erasable programmable read-only memory) – The data can be erased by applying an electric field, with no need for ultraviolet light. We can erase only portions of the chip.
· MROM(Mask ROM) – Mask ROM is a kind of read-only memory, that is masked off at the time of production. Like other types of ROM, mask ROM cannot enable the user to change the data stored in it. If it can, the process would be difficult or slow.

	Problems / questions  related to the above class         :     5 Minutes

	Attendance      :  5 Minutes 

	Reference        :  

	Lab taken by   : 






	Programme- Diploma Engineering 
Semester-1st& 2nd (Common) 
Course Code-Th 1b (Practical)
Periods/week-04 periods per week
Duration of period-55mins

	
Lab taken by   : 
Mr. Sabyasachi Sarangi
	
Lab Class No. 14
Week No.

	Course Name : Computer Application Practical


	Topic- Adapter Cards


	Essential Prerequisites : One computer set 


	Intended Learning Outcome expected- After the completion of this topic, students  will be able to understand and using the Adapter cards





Adapter cards are used to expand and customize the computer's capability: NIC connects a computer to a network using a network cable. Wireless NIC connects a computer to a network using radio frequencies
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	Problems / questions  related to the above class         :     5 Minutes

	Attendance      :  5 Minutes 

	Reference        :  

	Lab taken by   : 






	Programme- Diploma Engineering 
Semester-1st& 2nd (Common) 
Course Code-Th 1b (Practical)
Periods/week-04 periods per week
Duration of period-55mins

	
Lab taken by   : 
Mr. Sabyasachi Sarangi
	
Lab Class No. 15
Week No.

	Course Name : Computer Application Practical


	Topic-  Expansion slots in Computer


	Essential Prerequisites : One computer set 


	Intended Learning Outcome expected- After the completion of this topic, students  will be able to
Study about expansion slots in computer 




expansion slots in computer
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	Problems / questions  related to the above class         :     5 Minutes

	Attendance      :  5 Minutes 

	Reference        :  

	Lab taken by   : 







	Programme- Diploma Engineering 
Semester-1st& 2nd (Common) 
Course Code-Th 1b (Practical)
Periods/week-04 periods per week
Duration of period-55mins
	
Lab taken by   : 
Mr. Sabyasachi Sarangi
	
Lab Class No. 16
Week No.

	Course Name : Computer Application Practical


	Topic- SATA Connectors study of adapters  and converter. 

	Essential Prerequisites : 
	Intended Learning Outcome expected- After the completion of this topic, students  will be able to SATA Connectors study of adapters  and converter.




SATA connectors  study of adapters  and  converters 
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	Problems / questions  related to the above class         :     5 Minutes

	Attendance      :  5 Minutes 

	Reference        :  

	Lab taken by   : 








	Programme- Diploma Engineering 
Semester-1st& 2nd (Common) 
Course Code-Th 1b (Practical)
Periods/week-04 periods per week
Duration of period-55mins

	
Lab taken by   : 
Mr. Sabyasachi Sarangi
	
Lab Class No. 17
Week No.

	Course Name : Computer Application Practical


	Topic- Study  of  various types of LAB  safety  measures  (General  Safety , Electrical  Safety , Fire safety )


	Essential Prerequisites : One computer set 


	Intended Learning Outcome expected- After the completion of this topic, students  will be able to
Learn the LAB  safety  measures  (General  Safety , Electrical  Safety , Fire safety ) 





SAFE LAB PROCEDURES
This section discusses safety in the lab. Safety guidelines help protect individuals from accidents and injury. They also help to protect equipment from damage. Some of these guidelines are designed to protect the environment from contamination caused by improperly discarded materials.
GENERAL SAFETY
Safe working conditions help prevent injury to people and damage to computer equipment. A safe workspace is clean, organized, and properly lighted. Everyone must understand and follow safety procedures.
Follow the basic safety guidelines to prevent cuts, burns, electrical shock, and damage to eyesight. As a best practice, make sure that a fire extinguisher and first-aid kit are available in case of fire or injury. Poorly placed or unsecured cables can cause tripping hazards in a network installation. Cables should be installed in conduit or cable trays to prevent hazards.
This is a partial list of basic safety precautions to use when working on a computer:
· Remove your watch and jewelry and secure loose clothing.
· Turn off the power and unplug equipment before performing service.
· Cover sharp edges inside the computer case with tape.
· Never open a power supply or a CRT monitor.
· Do not touch areas in printers that are hot or that use high voltage.
· Know where the fire extinguisher is located and how to use it.
· Keep food and drinks out of your workspace.
· Keep your workspace clean and free of clutter.
· Bend your knees when lifting heavy objects to avoid injuring your back.
ELECTRICAL SAFETY
Follow electrical safety guidelines to prevent electrical fires, injuries, and fatalities in the home and the workplace. Power supplies and CRT monitors contain high voltage.




CAUTION
Do not wear the antistatic wrist strap when repairing power supplies or CRT monitors. Only experienced technicians should attempt to repair power supplies and CRT monitors.
Some printer parts become hot during use, and other parts might contain high voltage. Check the printer manual for the location of high-voltage components. Some components retain a high voltage even after the printer is turned off. Make sure that the printer has had time to cool before making the repair.
Electrical devices have certain power requirements. For example, AC adapters are manufactured for specific laptops. Exchanging power cords with a different type of laptop or device may cause damage to both the AC adapter and the laptop.
FIRE SAFETY
Follow fire safety guidelines to protect lives, structures, and equipment. To avoid an electrical shock and to prevent damage to the computer, turn off and unplug the computer before beginning a repair.

Fire can spread rapidly and be very costly. Proper use of a fire extinguisher can prevent a small fire from getting out of control. When working with computer components, be aware of the possibility of an accidental fire and know how to react. Be alert for odours emitting from computers and electronic devices. When electronic components overheat or short out, they emit a burning odour. If there is a fire, follow these safety procedures:
· Never fight a fire that is out of control or not contained.
· Always have a planned fire escape route before beginning any work.
· Get out of the building quickly.
· Contact emergency services for help.
· Locate and read the instructions on the fire extinguishers in your workplace before you have to use them.
Be familiar with the types of fire extinguishers used in your country or region. Each type of fire extinguisher has specific chemicals to fight different types of fires:
· Paper, wood, plastics, cardboard
· Gasoline, kerosene, organic solvents
· Electrical equipment
· Combustible metals
It is important to know how to use a fire extinguisher. Use the memory aid P-A-S-S to remember the basic rules of fire extinguisher operation:
· P: Pull the pin.
· A: Aim at the base of the fire, not at the flames.
· S: Squeeze the lever.
· S: Sweep the nozzle from side to side.

	Problems / questions  related to the above class         :     5 Minutes

	Attendance      :  5 Minutes 

	Reference        :  

	Lab taken by   : 





	Programme- Diploma Engineering 
Semester-1st& 2nd (Common) 
Course Code-Th 1b (Practical)
Periods/week-04 periods per week
Duration of period-55mins

	
Lab taken by   : 
Mr. Sabyasachi Sarangi
	
Lab Class No. 18
Week No.

	Course Name : Computer Application Practical


	Topic- Study  of  various types of LAB  safety  measures  (General  Safety , Electrical  Safety , Fire safety )


	Essential Prerequisites : 

	Intended Learning Outcome expected- After the completion of this topic, students  will be able to Learn the LAB  safety  measures  (General  Safety , Electrical  Safety , Fire safety ) 




POWER FLUCTUATION TYPES
Voltage is the force that moves electrons through a circuit. The movement of electrons is called current. Computer circuits need voltage and current to operate electronic components. When the voltage in a computer is not accurate or steady, computer components might not operate correctly. Unsteady voltages are called power fluctuations.
The following types of AC power fluctuations can cause data loss or hardware failure:
· Blackout: Complete loss of AC power. A blown fuse, damaged transformer, or downed power line can cause a blackout.
· Brownout: Reduced voltage level of AC power that lasts for a period of time. Brownouts occur when the power line voltage drops below 80 percent of the normal voltage level. Overloading electrical circuits can cause a brownout.
· Noise: Interference from generators and lightning. Noise results in poor quality power, which can cause errors in a computer system.
· Spike: Sudden increase in voltage that lasts for a short period and exceeds 100 percent of the normal voltage on a line. Spikes can be caused by lightning strikes, but can also occur when the electrical system comes back on after a blackout.
· Power surge: Dramatic increase in voltage above the normal flow of electrical current. A power surge lasts for a few nanoseconds, or one-billionth of a second.
POWER PROTECTION DEVICES
To help shield against power fluctuation problems, use power protection devices to protect the data and computer equipment:
· Surge suppressor: Helps protect against damage from surges and spikes. A surge suppressor diverts extra electrical voltage that is on the line to the ground.
· Uninterruptible power supply (UPS): Helps protect against potential electrical power problems by supplying a consistent level of electrical power to a computer or other device. The battery is constantly recharging while the UPS is in use. The UPS provides a consistent quality of power when brownouts and blackouts occur. Many UPS devices can communicate directly with the computer operating system. This communication allows the UPS to safely shut down the computer and save data prior to the UPS losing all electrical power.

· Standby power supply (SPS): Helps protect against potential electrical power problems by providing a backup battery to supply power when the incoming voltage drops below the normal level. The battery is on standby during normal operation. When the voltage decreases, the battery provides DC power to a power inverter, which converts it to AC power for the computer. This device is not as reliable as a UPS because of the time it takes to switch over to the battery. If the switching device fails, the battery cannot supply power to the computer.
CAUTION
UPS manufacturers suggest never plugging in a laser printer to a UPS because the printer could overload the UPS.

 PROCEDURES TO PROTECT THE ENVIRONMENT
Most computers and peripherals use and contain at least some materials that can be considered toxic to the environment. This section describes tools and procedures that help identify these materials and the steps for the proper handling and disposal of the materials.
MATERIAL SAFETY AND DATASHEET
Computers and peripherals contain materials that can be harmful to the environment. Hazardous materials are sometimes called toxic waste. These materials can contain high concentrations of heavy metals such as cadmium, lead, or mercury. The regulations for the disposal of hazardous materials vary by state or country. Contact the local recycling or waste removal authorities in our community for information about disposal procedures and services.
A Material Safety and Data Sheet (MSDS) is a fact sheet that summarizes information about material identification, including hazardous ingredients that can affect personal health, fire hazards, and first-aid requirements. To determine whether a material is classified as hazardous, consult the manufacturer‘s MSDS. In the United States, the Occupational Safety and Health Administration (OSHA) requires that all hazardous materials be accompanied by an MSDS when transferred to a new owner. The MSDS information included with products purchased for computer repairs or maintenance can be relevant to computer technicians. OSHA also requires that employees be informed about the materials that they are working with and be provided with material safety information. Following Figure shows the OSHA website where you can find the MSDS form and more information.
NOTE
The MSDS is valuable in determining how to dispose of potentially hazardous materials in the safest manner. Always check local regulations concerning acceptable disposal methods before disposing of any electronic equipment.
The MSDS contains valuable information:
· Name of the material
· Physical properties of the material
· Hazardous ingredients contained in the material
· Reactivity data, such as fire and explosion data
· Procedures for spills and leaks
· Special precautions
· Health hazards
· Special protection requirements
In the European Union, the regulation Registration, Evaluation, Authorization and restriction of Chemicals (REACH) came into effect on June 1, 2007, replacing various directives and regulations with a single system.

	Problems / questions  related to the above class         :     5 Minutes

	Attendance      :  5 Minutes 

	Reference        :  

	Lab taken by   : 





	Programme- Diploma Engineering 
Semester-1st& 2nd (Common) 
Course Code-Th 1b (Practical)
Periods/week-04 periods per week
Duration of period-55mins

	
Lab taken by   : 
Mr. Sabyasachi Sarangi
	
Lab Class No. 19
Week No.

	Course Name : Computer Application Practical


	Topic- Power protection device  (Surge  suppressor , UPS, Standby  power supply )


	Essential Prerequisites : One computer set 


	Intended Learning Outcome expected- After the completion of this topic, students  will be able to
Learn about Power protection device



[image: ]Electrical power protection device 

[image: ]power  protection devices 
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	Problems / questions  related to the above class         :     5 Minutes

	Attendance      :  5 Minutes 

	Reference        :  

	Lab taken by   : 






	Programme- Diploma Engineering 
Semester-1st& 2nd (Common) 
Course Code-Th 1b (Practical)
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Lab taken by   : 
Mr. Sabyasachi Sarangi
	
Lab Class No. 20
Week No.

	Course Name : Computer Application Practical


	Topic- Procedures  for  proper  disposal  or recycling of  hazardous  computer  componenets  (Batteries , monitors  , toner  kit , cartridges , chemical  solvents  and  aerosol cans 

	Essential Prerequisites : 

	Intended Learning Outcome expected- After the completion of this topic, students  will be able to



[image: ]Hardware Tools (2.2.1)
For every job there is the right tool. Make sure that you are familiar with the correct use of each tool and that the correct tool is used for the current task. Skilled use of tools and software makes the job less difficult and ensures that tasks are performed properly and safely.
General Tool Use (2.2.1.1)
Computer repair requires some task-specific tools. Make sure that you are familiar with the correct use of each tool and that the correct tool is used for the task. Skilled use of tools and software makes the job less difficult and ensures that tasks are performed properly and safely.
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Disk Management Tools
Disk management tools are utility software that is used to manage data on disk by performing various functions on it. Moreover, they perform functions like partitioning devices, manage drives, disk checking, disk formatting, etc. Furthermore, there are various types of disk management tools like disk checkers, disk cleaners, and disk analyzers.
We also call these tools as disk utility. Utility Software or system utilities is a type of system software that helps in the proper and smooth functioning of a computer system. Moreover, they assist the operating system to manage, organize, maintain, and optimize the functioning of a computer system. Examples of disk management tools are MiniTool Partition Wizard, Paragon Partition Manager, etc.
Basic Functions of Disk Management Tools
The disk utility basically takes care of the computer disk system. It performs all the tasks which are necessary to keep the functioning of the disk smooth. Some basic functions that these tools perform are as follows:
· Partitioning of the disk
· Formatting the disk
· Changing disk’s name




· Shrinking a disk partition
· Extending a disk partition
· Deleting a disk partition
· Changing the file system of a driver
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Types of Disk Management Tools
1. Disk Cleanup Tools
These tools clean up the unnecessary and unwanted files on the system. Furthermore, this deletion of files thus helps to clean up the disk space. Moreover, it prevents unnecessary clutter and protects privacy.
Temporary files, web caches, old backups, etc. are the files that make up the unwanted clutter on the disk. Privacy risk happens due to files that have information about files opened by each computer program. For example log files, HTTP cookies, etc. Examples of disk cleanup tools are Razer Cortex, Piriform CCleaner, etc.
[image: Disk Management Tools]
                                               Disk Cleanup Tool




2. Disk Compression Tools
The disk compression tools or disk compression utility increases the amount of space on a disk by decreasing the size of information. The utility compresses the information while storing it on this disk. On the other hand, the information decompresses when we have to read it. Examples of disk compression utility are as follows:
· Microsft Windows: DriveSpace
· Macintosh: DiskDoubler
3. Disk Checkers
These tools scan the hard disk and remove any such areas which are corrupted or not saved properly. Furthermore, they perform this process so that the hard disk can operate more efficiently. Some tools perform the full surface scan while some others check only logical structures of the files.
Examples are CHKDSK, fsck, etc.
[image: Disk Checker]
                                            Disk Checker
4. Disk Formatters
They prepare a data storage device for the initial use. For example devices like hard disk, floppy disk, USB flash drive, etc. Moreover, they can also permanently erase a drive.


The formatting has three levels:
· Low-level formatting
· Partitioning
· High-level formatting
5. Disk Partitioning Tools
These tools divide the disk into more than one region. Furthermore, it does this so that each region can be managed separately and hence, more efficiently. These regions are the partitions. A partition table is also maintained which contains information about the location and size of each partition. Examples are GParted, diskpart, GNU Parted, etc.
[image: GParted]
                                                  GParted
6. Disk Space Analyzers
These tools indicate the space usage on the disk. Furthermore, they perform this task by analyzing the size of each file and folders and also, the subfolders. Usually, this information is indicated through graphical charts according to the folders’ size or other criteria. We can also call them as disk usage analysis software. Examples are DiskReport, KDE Filelight, GNOME Disk Usage Analyzer, etc.
[image: GNOME Disk Analyzer]
                                     GNOME Disk Analyzer
7. Disk Defragmenter
This utility software helps to reduce the fragmentation and hence, reduces the access speed. Defragmenting refers to rearranging files and storing them in contiguous memory locations. This means that when the contents of some files are scattered here and there it rearranges them and stores them in a contiguous memory area. These scattered parts are fragments. Moreover, saves time in reading from files and writing files to disk. Examples of disk defragmenters are Perfect disk, Deflaggler, etc.
8. Backup Software
This keeps a copy of all the information on a disk. Whenever some disk failure occurs or files are deleted accidentally, it restores the files. Restoring the whole disk is called disk cloning.
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[image: ]
CLS (Clear Screen): These commands clear all the text from the screen and shows user a Command Prompt. The difference between using cls and simply closing the current Command Prompt window and opening a new one is that the working environment (such as the current directory) is preserved with cls. 
Syntax: C:\>CLS (Press Enter) It Clears the screen.

DIR: The DIR command is used to display all the available files and directories (except the hidden and system files) in the current directory. The DIR command, on execution, displays the disk's volume label and serial number; one directory or filename per line, including the filename extension, the file size in bytes, the date and time the file was last modified; and the total number of files listed, their cumulative size, and the free space (in bytes) remaining on the disk.
Syntax:	C:\>DIR [drive:][path][filename] [parameters]



Parameter:
	/W:
	Displays the listing in wide format, with as many as five filenames or directory names on each line.

	/D:
	Same as /W except files are sorted vertically.

	/l:
	Use lower case

	/O:
	Sort order(List files in sorted order)

	/E :
	By extension (sorted alphabetically)

	/G:
	Group directories first

	/N:
	By name (sorted alphabetically)

	/S:
	By size (smallest first). To list all the files in the current directory

	/4:
	Display the listed years as four digits. By default, two-digit years
are displayed.

	/P:
	Pause at every page

	/Axx:
	Display files with the specified attributes only

	/B:
	Uses bare format (no heading information or summary)



attrib
Attrib views or changes the attributes of one or more files. It defaults to displaying the attributes of all files in the current directory.
ATTRIB [+R|-R] [+A|-A] [+S|-S] [+H|-H][drive:][path][filename] [/S [/D]]

To add an attribute attach a '+' in front of it.
· To remove an attribute attach a '-' in front of it.
· Attributes include
· R - Read-only
· A - Archive
· S - System
· H - Hidden
· /D - Process folders as well.
· /S - Process matching files in the current folder and all subfolders.
For Example:
i. C:\>DIR (Press Enter)
A list of the files and sub directories in the WINDOWS C:\ directory(current directory) appears, but scrolls by too quickly to read. The DIR command can be modified so that it displays only one screen of information at a time.





ii. To view the contents of a directory one screen at a time:
The following command is typed at the command prompt:
Syntax : C:\>DIR /P
One screen of information appears. At the bottom of the screen, we will see the following message :
Press any key to continue . . .
To view the next screen of information, any key on the keyboard can be pressed. This step can be repeated until the command prompt appears at the bottom of the screen.
iii. To view the contents of a directory in wide format :
The following command is typed at the command prompt:
Syntax:	C:\>DIR /W
File and directory names are listed in columns and sorted horizontally. Note that only filenames are listed. No information about the files' size or date and time of creation appears.
iv. If the directory contains more files than will fit on one screen, the /p and /w switches can be combined as follows:
Syntax:	C:\>DIR/W /P

If we want to create new.txt file in C:\ storing the result, then type
C:\>dir> filename.txt
0. DATE : DATE command is an internal basic DOS commands which is used to display the current date setting and you are prompted for entering a new one. Press Enter to keep the same date. The current date setting is displayed in the format of dd-mm-yy[yy].
Syntax:
C:\>DATE (Press Enter)
The current date is: 26-12-2020
Enter the new date: (Press enter to keep the same date)

0. TIME: Time command is used to display or change the current time of Computer System. The format which is used by time command is HH:MM:SS.CC. Where HH stands for Hours of the day in 24-hour format, MM for Minutes, SS for seconds and CC for Hundredths of a Second.
Syntax:
C:\>TIME (Press Enter)
The current time is: 9:37:24.52
Enter the new time: (Press enter to keep the same time)
0. VER(VERSION) : The VER command is used to display the current version of MSDOS used.
Syntax:
C:\> VER  (Press Enter) Microsoft Windows [version 10.0]
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1. MKDIR/MD : MD or MKDIR command is an internal DOS command which is used to create directories and subdirectories under the current directory.
Syntax:
C:\>MD(directoryname)(PressEnter) or
C:\>MKDIR(directoryname)(PressEnter)
For example if we need to create a directory named diploma under C:\,we have to type the DOS command as follows.
C:\> MD diploma (Press Enter) or
C:\>MKDIR diploma (Press Enter)
The sub directory named diploma is now created under C:\

0. CHDIR/CD: CD (or) CHDIR is an internal DOS command which is used to switch directories in MS DOS.
Syntax:
C:\>CD(directory name)(Press Enter) or
C:\>CHDIR(directory name)(Press Enter)
For example if we need to change to the newly created directory named diploma under C:\, we have to type the DOS command as follows.
C:\> CD diploma (Press Enter) or
C:\>CHDIR diploma (Press Enter) The prompt changes to C:\diploma>
· CD : Displays the current working directory on the current drive. For example:
C:\diploma>CD(Press Enter) Displays C:\diploma
· CD.. : Changes the working directory to parent directory(Up one level). 



· For example:
C:\diploma>CD..(Press Enter) The prompt changes to C:\>
· CD\ : Changes the working directory to the root directory(Top level) of the current drive. For example:
C:\diploma>CD\(Press Enter) The prompt changes to C:\>
0. RMDIR/RD: RD (or) RMDIR is an internal DOS command which is used to remove the empty directory/subdirectory. To remove a sub directory we have to execute the RD command in the parent directory.
Syntax:
C:\>RD(directoryname)(PressEnter) or
C:\>RMDIR(directoryname)(PressEnter)

for example,
C:\>RD diploma (Press Enter)
Will remove the empty subdirectory diploma under C:\
0. DEL : DEL is a Basic internal DOS command which is used to delete the specific mentioned file without sending them to recycle bin. If we do not specify the drive or path, the file is assumed to be in the current directory.
Syntax:
C:\>DEL[/p][/f][/s/[/q][/a:attributes](file name)(PressEnter) C:\>ERASE[/p][/f][/s/[/q][/a:attributes](file name)(PressEnter)
The DEL options are:
	filename
	Specifies the file(s) to delete. If we do not specify the drive or path, the file is assumed to be in the current directory.

	/p
	Prompts for confirmation before deleting each file.

	/f
	Forces deletion of read-only files.

	/s
	Deletes specified files in all subdirectories (when using
wildcards).

	/q
	Quiet mode; do not prompt if filename is *.*.

	/a : attributes
	Selects files to delete based on attributes (read-only,
hidden, system, or archive).






For example:
i. To delete the file abc.com under C:\, we can execute the following command: C:\>DEL abc.com (Press Enter)
ii. To delete the file myfile.txt in the C:\files directory:
C:\> DEL C:\files\myfile.txt
iii. To delete all the files with the pattern myfile.* (e.g., myfile.doc, myfile.txt, etc.) in the current directory, but prompt for each deletion:
C:\> DEL C:\files\myfile.* /p
iv. To delete files in a group, we can use wild cards as follows:
C:\>DEL * .abc (Press Enter)
In the above command all the files in C:\ which have an extension .abc will be deleted.
0. COPY: COPY is a Basic internal DOS command which is used to copy files from one location to another. When we use the copy command, we must include two parameters. The first is the location and name of the file we want to copy, or the source. The second is the location to which  we want to copy the file, or the destination. We separate the source and destination with a space. The destination defaults to the current directory. So the destination can be omitted to copy the specified  files  to  the  current  working  directory.  If   another  file  by  the  same  name  exists     at destination, we will be asked whether we want to overwrite it. If the file (or files) to be copied is in a different directory or on a different disk, we can omit the destination filename. In that case, the resulting copy or copies will have the same name as the original. If multiple source files are indicated, the destination must be a directory, or an error will result.
Syntax:
Copy [source\filename] [destination\folder] (Press Enter)
Copy [/a|/b] source [/a|/b] [+ source [/a|/b][+…]] [destination[/a|/b]] [/v] [/y|/-y][/d] [/z] [/n] [/l]

	/a
	Specifies that the file to copy is in ASCII format.

	/b
	Specifies that the file to copy is a binary file.

	/v
	Verifies that new files are written successfully by comparing them with the originals.

	/y
	Suppresses prompting to confirm that you want to overwrite an existing destination file.

	/-y
	Enables prompting to confirm that you want to overwrite an existing destination file
with the same name (default).

	/d
	Allows the new file to be created as a decrypted file (NTFS volumes only).

	/l
	When copying a symbolic link (see "mklink," later in this chapter), copies the file as a link rather than making a couple of the source file (the default behavior).

	/n
	Copies the file using the short filename that Vista generated for compatibility with DOS, old versions of Windows, and devices that can't support long filenames on their flash memory.

	/z
	Copies networked files in restart able mode. If the network connection is lost during copying (if the server goes offline and severs the connection, for example), /z will
resume the copying after the connection is reestablished.






For example:
i. If we want to copy abc.txt file from C:\Dos folder to D drive, simple the following command can be executed:
Firstly the directory is changed to Dos folder using CD Dos then we can execute the following command:
C:\Dos>COPY abc.txt D:\ which will copy the file to D:\ drive.

ii. Suppose if we want to copy all the text files present in the Dos folder to D:\ , we can execute the following command:
C:\Dos>COPY *.txt D:\ which will copy all text file.
iii. Copy all the files from the directory d:\cdsample\Images to the current directory,	giving the copies the same names as the originals:
C:\>copy d:\cdsample\Images\*.* or
C:\>copy d:\cdsample\Images\*.* .
iv. It is also possible to use the copy command to concatenate (combine) files. To concatenate files, specify  a   single  file  for   the  destination   but   multiple  files  for  the  source  (using   wildcards   or file1+file2+file3 format):
For example:
C:\>copy mon.txt+tue.txt+wed.txt report.txt

v. COPY CON : We can also use the con device (console) in conjunction with copy. To create a new text file by typing its contents directly through the command prompt from the key board, first we have to execute:
C:\> COPY CON mytest.txt (Press Enter)
After this command is executed, we'll be returned to a blank line, which is the start of the file. Then type the text to be saved into the file. When we're done, type Ctrl-Z and press Enter. All the text typed from the keyboard in this example is then saved as mytest.txt. If we want to cancel the creation of the file, press Ctrl + C.
vi. To copy the contents of the file mytest.txt to the screen C:\>copy mytest.txt con
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0. TYPE : Type command is used to view the content of the file.
To use this command, first we have to go to the desired destination where the file is being stored. Then we have to type:
Syntax:
C:\> Type [drive:][path]filename(Press Enter)
For example: To view the file abc.txt stored in C:\ , we can execute the following command:
C:\>type abc.txt (Press Enter) Displays the file contents
If the content of the file is large and cannot be entirely viewed on the display device use the following MS-DOS command.
Syntax
C:\> type abc.txt more (Press Enter)
To edit the files, the user would need to use either edit or copy con.
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0. REN: This Basic DOS Command is used for renaming an existing file or directory.
Syntax
C:\>REN (old file name) (new file name) (Press Enter)

For Example:
i. To rename a file named abc.com in C:\ to computer.com. Use the below command. C:\>REN abc.com computer.com (Press Enter)
ii. Now if we need to change the name and extension of files in a group. We need to use wildcards as given below
C:\>REN *.com *.abc (Press Enter)
Here all the .com extension files in C:\ will be renamed to .abc
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Windows Operating System
The operating system window is the extension of the disk operating system. It is the most popular and simplest operating system; it can be used by any person who can read and understand basic English, as it does not require any special training.
However, the Windows Operating System requires DOS to run the various application programs initially. Because of this reason, DOS should be installed into the memory and then window can be executed.
Elements of Windows OS
Following are the significant element of Windows Operating System (WOS) −
· Graphical User Interface
· Icons (pictures, documents, application, program icons, etc.)
· Taskbar
· Start button
· Windows explorer
· Mouse button
· Hardware compatibility
· Software compatibility
· Help, etc.
Once you are logged in a window computer system, you will get dozens of applications, so you can choose an option of your requirement.
Many of the options have shortcut icon readily available on your computer screen; however, in some computers, you may not find any such option on the screen; in such a case, you can take the help of menu button (as shown in the image given below) – 







[image: Windows Desktop Elements]Start Menu Options
The following table lists down the options that appear after clicking on the Start menu −
Option & Description

All programs : It displays all those programs, which are installed in your system.
Document: It displays a list of folders used by the user.
Recent file : It displays the recently used file.
My picture :It displays a list of pictures.
My music : It displays a list of music/song, etc.

My computer : It displays the drives of computer where user keeps his/her work, file, folder, song, video, picture, e-book, etc.
Control panel: It displays all the installed computer programs (software).
Printer : It displays the installed printers (if printer is installed in the system, user can take print easily).
Help (support) : It helps users to know how to do a particular task.
Search : It helps a user to find a file in computer.
Run: It helps to start an application program or execute a DOS command.
Setting : It has different options that help to manage different settings of the computer, software as well as hardware.
Log Off :It helps a user to log off the currently logged in user of the system.
Sleep :It makes the system non-functional; however, puts the ongoing work and settings in memory and also keeps drawing small amount of power.
Hibernation : Hibernation puts the open documents and programs on hard disk and then turns off your computer; in comparison to ‗sleep‘, it uses very low power.
Restart: Its function is to shut down and again start (log on) computer; it is done normally to refresh computer especially when computer is hanged.
Shut down : It simply shuts down the system.
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Recycle Bin
[image: Windows 10 Control Panel][image: Recycle Bin]Recycle Bin is a trash location where deleted files remain stored. Once you delete any sort of file, it gets stored (automatically) into recycle bin; therefore, if you mistakenly deleted some important file, don‘t panic, go to recycle bin and restore it. However, if you deleted file from recycle bin as well, then it is very difficult to restore that permanently deleted file.
Control Panel
[image: ]The Control Panel is a section of Microsoft Windows that enables a user to change various computer hardware and software features. Settings for the mouse, display, sound, network, and keyboard represent just a few examples of what may be modified in the Control Panel. Below the Control Panel appeared in Windows.
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Accessories : Windows operating system ships with some handy applications known as Windows accessories. Calculator, Notepad, Paint, Explorer, WordPad are some of the most frequently used accessories.

[image: https://mcqsets.com/wp-content/uploads/2015/04/Calculator-on-Windows-7.png]Calculator : Windows Calculator is a calculating application included in all the versions of Windows. It can be used to perform simple calculation, scientific calculation and Programming calculation.
· Choose Start >> Programs >> Accessories >> Calculator to start Calculator application, or

· Alternately you can open Run dialog box (Start >> Run) dialog box then type calc and hit enter.
· [image: MS Paint Application]From View menu choose the required type of calculator – Standard, Scientific, Programmer, Statistical
Paint
Paint (formerly Paintbrush for Windows) is a simple graphics painting program that has been included with all versions of Microsoft Windows. It is often referred to as MS Paint or Microsoft Paint. The program opens and saves files as Windows bitmap (24-bit, 256 color, 16 color, and monochrome) .BMP, JPEG, GIF. Paintbrush supports GIF without animation or transparency. Since Windows 98 Paint supports GIF with transparency. It also supports PNG (without alpha channel), and TIFF (without multiple page support).
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[image: Notepad]
Notepad
Notepad is a common text-only (plain text) editor. The resulting files—typically saved with the
[image: WordPad].txt extension—have no format tags or styles, making the program suitable for editing system files that are to be used in a DOS environment.Notepad supports both left-to-right and right-to-left based languages, and one can alternate between these viewing formats by using the right or left Ctrl+Shift keys to go to right-to-left format or left-to-right format, respectively.
WordPad
Microsoft WordPad is a free rich text editor included with Microsoft Windows 95 and the later. Earlier to Windows 95 there used to be an application called Write for the same task. Although capable of doing much more than Notepad, WordPad is not as advanced as Microsoft Word.
WordPad can format and print text, but lacks intermediate features such as a spell checker, thesaurus, and support for tables. As such, it is suitable for writing letters or short pieces, but underpowered for work that relies heavily on graphics or typesetting.
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A - 1 Operating System Installation Guidelines The following document guides you step-by-step through the process of installing the operating systems so they are properly configured for boot camp. The document is divided into 3 parts:
 1. Windows XP Installation 
2. Linux Installation 
3. VMWare Installation 
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	Topic- Microsoft Office

	Essential Prerequisites : 
	Intended Learning Outcome expected- After the completion of this topic, students  will be able to work in Microsoft Office




1. The Screen and its Elements
In this section, we review the basic structure of Word 2007. You start the program by clicking the Windows Start
Button at the bottom left, then click Programs. In the Programs menu there is a folder called Microsoft Office,
and this is of course where you find Word.
[image: ]When you start Word, you automatically start in a new blank document.

On its surface Word 2007 is a very simple and attractive program, and it is undoubtedly relatively easy to use, but
there are some elements you need to familiarise yourself with.










1.1 The Office Button
[image: ]In the upper left corner of the screen, you will find the round Office Button. It corresponds basically to the old
"Files" menu.



When you click on the Office Button, a menu pops up. It is this menu you must enter when you want to create a
new blank document, and when you need to save it. You will also find menu items for Preview and Print.

Word 2007

14

1. The Screen and its Elements
[image: ]
It is also via the Office Button you get to Word Options, where you can configure a wide range of basic Options
that determine how Word functions. If you are not very familiar with Word, you should stay far away from
Options at this point.
1.2 Quick Access : The small, discrete ”Quick Access” Toolbar is located just to the right of the Office Button. Using Quick Access, you can save, undo, etc. with a single click. "Quick Access" can be customized so you can choose the features that suit you. To do this, right-click on any button and choose Customize Quick Access Toolbar. Alternatively you can click the small arrow to the right of the Toolbar to enable you to quickly select and deselect features.

Print Layout : Print Layout is the default View. In this View, what you see on the screen is similar to the print-out. 

Full Screen Reading : Full Screen Reading is reminiscent of the Print Layout, but Ribbons and various buttons are hidden, so the screen space is used to display the document. This is a good View when you need to read a document on the screen.
 
Web Layout  : This View shows how your document would look if you saved it as a Web page. Word can save documents in  HTML format, so you can actually create simple Web pages in the program. However, I would recommend that  you use a real Web site program for this purpose

The Status Bar
The Status Bar, in the bottom left of the screen, shows at all times which page you are on, how many pages there
are in total, and how many words there are in the document. There is also a small icon that moves as you type. It
shows the Spelling and Grammar Check is active

Creating a New Document

When Word starts up, the program will display a new blank document - that is, a completely blank piece of paper
which you can begin to write on. That is fine most of the time, but you do not have to start from a completely
blank page. Word can help you lay out your documents neatly, so it is easy, for example, to design a nice
letter. This is done through a variety of built-in Templates that were installed with the program. You can
download even more Templates from the Internet.
If this is not enough for you, you can also create your own Templates once you are familiar with the program.

 Starting on a New Blank Document
You do not have to confine yourself to working in one document at a time. You can have as many documents
open as your computer's memory allows. In most cases, this means more than you will ever need.
Let us try to start a couple of new documents, so you can get an idea of your options.
1. Click on the Office Button in the top left corner of the screen.
2. Click on New. (the exercise continues)


[image: ]
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	Topic-  Margin and Page setup


	Essential Prerequisites : One computer set 


	Intended Learning Outcome expected- After the completion of this topic, students  will be able to Set up the pages for printout 




Margins
There are three things to remember when aligning margins:
 Should there be room for headers and footers?
 Should there be room for holes in the paper?
 Does it look nice?
Whether the document looks nice is of course a subjective matter. As a rule of thumb, the margins should not be
too small, meaning less than 1 cm. The pages will look too heavy if there is not enough space around the
text. Conversely, 3 cm would probably look a little crazy on an A4 page.
I usually work with a 2-cm margin on the left side and 1.5 cm on the right side. At the top I also have 1.5 cm,
and at the bottom it is 2 cm. I think this gives a nice, balanced appearance.
However, if someone out there with graphic training should disagree with me, I defer.
[image: ]When you read this book and look at the margins, you will discover that I have not used these sizes in the
book. This is because I have let the publisher do the layout and concentrated on writing a good book.

 Adjusting the Margins – 
Enough talk about sizes of margins, now we will try to adjust them. There are two ways to adjust the
margins. You can either adjust them visually with the mouse or edit them in the document settings for page
setup. Visual adjustment is quick and reasonably accurate. Editing page setup is completely accurate, but it takes
a little longer.


















4. Page Layout
[image: ]
First I will show you how to adjust the margins using the mouse. It is quick, and I prefer this method myself. On
certain occasions it might be necessary to adjust margins via page setup.
I will return to that in the next section.
1. First ensure that you are in the Print Layout View. Click on the View Tab in the Ribbon and make sure
the Print Layout button is pressed.
2. On the same Tab in the Ribbon, you must also make sure that the rulers are displayed. There should be
a ”tick” by Ruler.

A horizontal ruler is now being displayed at the top along with a vertical ruler on the left side. The rulers are
white inside the document margins and light blue outside. When you place the mouse on the border between the
white and light blue areas, the mouse arrow changes to a double-headed arrow.
To adjust the margins with complete accuracy, click on the Margins button in the Page Layout Tab.

This opens a menu where you can choose between five different pre-designed configurations, including a two-sided setup. But if you click Custom Margins, you get access to fine-tuning everything.
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	Topic-  Header and footer setting

	Essential Prerequisites : 

	Intended Learning Outcome expected- After the completion of this topic, students  will be able to set header & footer of the desired page


Setting Header & footer
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	Topic- MS Excel

	Essential Prerequisites : 
	Intended Learning Outcome expected- After the completion of this topic, students  will be able to work by using MS Excel


What is MS Excel?
Microsoft Excel is a spreadsheet program that lets you organize and calculate large amounts of data, and it’s a favorite for businesses and individuals. 

Excel spreadsheets are popular because they offer so many features, are easy to use, and can be created by anyone. However, with so many features, it can be hard to find out how to do the basic things in Excel.
[image: ]

What is an Excel workbook?
An Excel workbook is a collection of the sheets in an Excel file. In other words, it’s the file itself where all the sheets are stored. The term “workbook” refers to any type of notebook that usually contains more than one sheet of paper (hence the word “multiple”).



What is an Excel sheet?
An Excel sheet is a single page of a workbook. In other words, one sheet will be one page of the notebook mentioned above. Sheets are also called “tabs,” An entire workbook with multiple sheets is called “sheets.xlsx.” The easiest way to remember this is that “sheet” is spelled with X’s instead of C’s. 
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	Topic- 

	Essential Prerequisites : 
	Intended Learning Outcome expected- After the completion of this topic, students  will be able to
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	Topic- To set Margins 

	Essential Prerequisites : 
	Intended Learning Outcome expected- After the completion of this topic, students  will be able to set up the margins


[image: ]
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Print
The simplest way to print is to click the Office button, highlight Print on the menu that appears, and then click Quick Print in the Preview and Print the Document pane. Dotted lines appear on your screen, and your document prints. The dotted lines indicate the right, left, top, and bottom edges of your printed pages. To print from Microsoft Excel, you can proceed as follows:

1. Click on Microsoft Office Button
2. Highlight or point the mouse on Print. 
3. Click on Print. 
4. In the Name box, under Printer option, choose an appropriate printer.
 5. Under the Print Range option, choose appropriate range of pages to be
printed.
 6. Under Copies option, choose appropriate number of copies of each page
to be printed. 
7. Click on OK when ready.
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	Topic-  Chart in MS Excel

	Essential Prerequisites : 

	Intended Learning Outcome expected- After the completion of this topic, students  will be able to add chart in MS excel
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	Topic- Making Presentation using MS Power Point 

	Essential Prerequisites : 


	Intended Learning Outcome expected- After the completion of this topic, students  will be able to make presentation file
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	Topic- Contents to be added to MS Power point 

	Essential Prerequisites : 

	Intended Learning Outcome expected- After the completion of this topic, students  will be able to make presentation by using different contents to make effective presentation.
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	Topic – Add charts in MS Power point

	Essential Prerequisites :
	Intended Learning Outcome expected- After the completion of this topic, students  will be able to add chart in presentation.
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	Topic- Arranging slides 

	Essential Prerequisites : 

	Intended Learning Outcome expected- After the completion of this topic, students  will be able to arranging slide according to need of the presentation 
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	Topic-  Slide show

	Essential Prerequisites : One computer set 

	Intended Learning Outcome expected- After the completion of this topic, students  will be able to view the presentation
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	Topic- Internet 


	Essential Prerequisites : One computer set 


	Intended Learning Outcome expected- After the completion of this topic, students  will be able to
Learn about LAN & WAN connection  through Internet  




What is the Internet?
 The internet is the largest computer network in the world, connecting millions of computers. A network is a group of two or more computer systems linked together. 
There are two main types of computer networks: v Local Area Network (LAN): A LAN is two or more connected computers sharing certain resources in a relatively small geographic location, often in the same building. 
[image: ]Examples include home networks and office networks.
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	Topic-  Browsing through Internet 


	Essential Prerequisites : One computer set 


	Intended Learning Outcome expected- After the completion of this topic, students  will be able to
Learn how to Browse anything through Internet 



[image: ]BROWSER :
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	Topic- Internet Hardwares

	Essential Prerequisites : 

	Intended Learning Outcome expected- After the completion of this topic, students  will be able to to learn about the internet Hardwares.



[image: ]HARDWARE NEEDED :[image: ]
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	Topic-  Creating e-mail id


	Essential Prerequisites : 

	Intended Learning Outcome expected- After the completion of this topic, students  will be able to learn about e-mail



[image: ]Understanding Email Addresses

 To receive emails, you will need an email account and an email address. 
Also, if you want to send emails to other people, you will need to obtain their email addresses. It's important to learn how to write email addresses correctly, because if you do not enter them exactly right, your emails will not be delivered or they might be delivered to the wrong person.

[image: ] Email addresses are always written in a standard format that includes a username, the @ (at) symbol and the email provider's domain. The username is the name you choose to identify yourself and the email provider is the website that hosts your email account. Review the graphic for examples of how email addresses are written.
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	Topic- e-mail sending 


	Essential Prerequisites : 

	Intended Learning Outcome expected- After the completion of this topic, students  will be able to send an e-mails.



e-mail
[image: ]

Understanding the Email
 Interface Below are some examples of different email interfaces from the top webmail providers: 
Gmail, Yahoo! and Hotmail. 
Review the images below to become familiar with various email interfaces.
 Keep in mind that these examples will only provide a general overview. 
You can visit our Gmail topic to learn how to use an email application in detail. 
Inbox The inbox is where you'll view and manage emails you receive.
 Emails are listed with the name of the sender, the subject of the message and the date received.
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	Topic-  C- PROGRAMMING  


	Essential Prerequisites : 

	Intended Learning Outcome expected- After the completion of this topic, students  will be able to

“Write a program in C to  find the greatest  number  among three numbers ”



1. AIM OF THE EXPERIMENT : To find the greatest among three numbers.
	//WAP to find the greatest among three numbers. #include<stdio.h>
void main()
{
int num1,num2,num3; printf("Enter three numbers");
scanf("%d %d %d",&num1,&num2,&num3); if(num1>num2)
{
if(num1>num3)
printf("%d is largest",num1);
else
}
printf("%d is largest",num3);
else if(num2>num3)
printf("%d is largest",num2);
else
printf("%d is largest",num3);
getch();
}

	/*alternate way*/ void main()
{
int num1,num2,num3; clrscr();
printf("Enter three numbers");
scanf("%d %d %d",&num1,&num2,&num3); if(num1>num2 && num1>num3)
printf("%d is largest",num1); if(num2>num1 && num2>num3)
printf("%d is largest",num2); if(num3>num1 && num3>num2)
printf("%d is largest",num3); getch();
}

Output: Enter three numbers 7 9 8
9 is largest
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	Topic- C- PROGRAMMING


	Essential Prerequisites : One computer set 


	Intended Learning Outcome expected- After the completion of this topic, students  will be able to
to find average of n numbers by using loop 


AIM OF THE EXPERIMENT : WAP to find average of n numbers by using loop
//WAP to find average of n numbers by using loop #include<stdio.h>
void main()
{
int n,var,i; float avg,sum;
printf("Enter how many numbers do you want enter"); scanf("%d",&n);
printf("Enter the numbers:"); for(i=0;i<n;i++)
{
scanf("%d",&var); sum=sum+var;
}
avg=sum/n; printf("average=%f",avg); getch();
}

Output: Enter how many numbers do you want enter 5 Enter the numbers: 1 2 3 4 5
average=3
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	Topic- C- PROGRAMMING 


	Essential Prerequisites : One computer set 


	Intended Learning Outcome expected- After the completion of this topic, students  will be able to
Write a program to find whether a number is prime or not .



AIM OF THE EXPERIMENT : WAP to find whether a number is prime or not
// WAP to find whether a number is prime or not #include<stdio.h>
void main()
{
int num,i,count=0; printf("Enter a number:"); scanf("%d",&num); for(i=1;i<=num;i++)
{
if(num%i==0)
count++;
}
if(count==2)
printf("%d is a prime number",num);
else
printf("%d is a composite number",num);
getch();
}

Output:	Enter a number: 5
5 is a prime number
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	Topic- C- Programming 


	Essential Prerequisites : One computer set 


	Intended Learning Outcome expected- After the completion of this topic, students  will be able to
Write a program to find whether a number is palindrome or not 



AIM OF THE EXPERIMENT : WAP to find whether a number is palindrome or not
// WAP to find whether a number is palindrome or not #include<stdio.h>
void main()
{
int num,i,rem,rev=0,num1; printf("Enter a number:"); scanf("%d",&num); num1=num; while(num!=0)
{
rem=num%10; rev=rev*10+rem; num=num/10;
}
if(num1==rev)
printf("%d is a palindrome number",num1);
else
printf("%d is a not a palindrome number",num1);
getch();
}
Output:	Enter a number: 121
121 is a palindrome number
	Problems / questions  related to the above class         :     5 Minutes

	Attendance      :  5 Minutes 

	Reference        :  

	Lab taken by   : 






	Programme- Diploma Engineering 
Semester-1st& 2nd (Common) 
Course Code-Th 1b (Practical)
Periods/week-04 periods per week
Duration of period-55mins

	
Lab taken by   : 
Mr. Sabyasachi Sarangi
	
Lab Class No. 53
Week No.

	Course Name : Computer Application Practical


	Topic- C- PROGRAMMING 


	Essential Prerequisites : One computer set 


	Intended Learning Outcome expected- After the completion of this topic, students  will be able to
Write a program to find the sine series 




AIM OF THE EXPERIMENT : WAP to find the sine series
// WAP to find the sine series #include<stdio.h>
#include<math.h> //sine and M_PI is defined in math.h void main()
{
float angle,value; printf("Enter an angle:"); scanf("%f",&angle);
value=sin(angle*M_PI/180); //M_PI is a constant used to represent pi printf("sin(%.0f)=%.4f",angle,value);
getch();
}

Output:
Enter an angle: 30 sin(30)=0. 5
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	Topic -  C- Programming 


	Essential Prerequisites : One computer set 


	Intended Learning Outcome expected- After the completion of this topic, students  will be able to
Write a program to accept row wise and column wise element in a 2-D array and print them


AIM OF THE EXPERIMENT: WAP to accept row wise and column wise element in a 2-D array and print them
//WAP in C to accept row wise and column wise element in a two dimensional array and print  them.
	

Output:
	Enter nine elements, row wise: 1 2 3 4 5 6 7 8 9

1 2 3

	
	4 5 6

	
	7 8 9

	
	Enter nine elements, column wise: 1 2 3 4 5 6 7 8 9
1 4 7

	
	2 5 8

	
	3 6 9


#include<stdio.h> void main()
{
int mat[3][3],i,j;
printf("Enter nine elements, row wise:"); for(i=0;i<3;i++)
for(j=0;j<3;j++)
scanf("%d",&mat[i][j]);
//print the elements for(i=0;i<3;i++)
{
for(j=0;j<3;j++)
printf("%d ",mat[i][j]); printf("\n");
}
printf("Enter nine elements, column wise:"); for(i=0;i<3;i++)
for(j=0;j<3;j++)
scanf("%d",&mat[j][i]);
//print the elements for(i=0;i<3;i++)
{
for(j=0;j<3;j++)
printf("%d ",mat[i][j]); printf("\n");
}
getch();
}
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	Topic -  C- Programming 


	Essential Prerequisites : One computer set 


	Intended Learning Outcome expected- After the completion of this topic, students  will be able to
Write a program to accept row wise and column wise element in a 2-D array and print them


AIM OF THE EXPERIMENT: WAP to accept row wise and column wise element in a 2-D array and print them
//WAP in C to accept row wise and column wise element in a two dimensional array and print  them.
	

Output:
	Enter nine elements, row wise: 1 2 3 4 5 6 7 8 9

1 2 3

	
	4 5 6

	
	7 8 9

	
	Enter nine elements, column wise: 1 2 3 4 5 6 7 8 9
1 4 7

	
	2 5 8

	
	3 6 9


#include<stdio.h> void main()
{
int mat[3][3],i,j;
printf("Enter nine elements, row wise:"); for(i=0;i<3;i++)
for(j=0;j<3;j++)
scanf("%d",&mat[i][j]);
//print the elements for(i=0;i<3;i++)
{
for(j=0;j<3;j++)
printf("%d ",mat[i][j]); printf("\n");
}
printf("Enter nine elements, column wise:"); for(i=0;i<3;i++)
for(j=0;j<3;j++)
scanf("%d",&mat[j][i]);
//print the elements for(i=0;i<3;i++)
{
for(j=0;j<3;j++)
printf("%d ",mat[i][j]); printf("\n");
}
getch();
}

	Problems / questions  related to the above class         :     5 Minutes

	Attendance      :  5 Minutes 

	Reference        :  

	Lab taken by   : 




	Programme- Diploma Engineering 
Semester-1st& 2nd (Common) 
Course Code-Th 1b (Practical)
Periods/week-04 periods per week
Duration of period-55mins
	
Lab taken by   : 
Mr. Sabyasachi Sarangi
	
Lab Class No. 56
Week No.

	Course Name : Computer Application Practical


	Topic- C- PROGRAMMING 

	Essential Prerequisites :  


	Intended Learning Outcome expected- After the completion of this topic, students  will be able to
“Write a program in C to find the vowels in a given string”


	
AIM OF THE EXPERIMENT : WAP in C to find the vowels in a given string.
//WAP in C to find the vowels in a given string. #include<stdio.h>
#include<string.h> void main()
{
char str[10],i; printf("Enter a string:"); gets(str);
//find the vowels for(i=0;i<10;i++)
{ if(str[i]=='A'||str[i]=='a'||str[i]=='E'||str[i]=='e'||str[i]=='I'||str[i]=='i'||str[i]=='O'||str[i]=='o'||str[i]== 'U'||str[i]=='u')
{
printf("%c --> pos[%d]",str[i],i+1); printf("\n");
}
}
getch();
}

Output :
[image: https://lh4.googleusercontent.com/xnZzvuWZEsGiWZDF5DzvqPlUR7GuUUZyc9amZUtS0jZb2jOcXHNlsZBb1EUSxEILSvRO_-ikvEL-DnkYUY9nMcL29IfZlnlmARW0tNvgJd6KksdEsUUW7yRFKi9gs0v1Tu47YFgx]
	Problems / questions  related to the above class         :     5 Minutes

	Attendance      :  5 Minutes 

	Reference        :  

	Lab taken by   : 





	Programme- Diploma Engineering 
Semester-1st& 2nd (Common) 
Course Code-Th 1b (Practical)
Periods/week-04 periods per week
Duration of period-55mins

	
Lab taken by   : 
Mr. Sabyasachi Sarangi
	
Lab Class No. 57
Week No.

	Course Name : Computer Application Practical


	Topic- C- PROGRAMMING 

	Essential Prerequisites : One computer set 


	Intended Learning Outcome expected- After the completion of this topic, students  will be able to “Write a program in C to find the factorial of a number using recursion”



AIM OF THE EXPERIMENT: WAP in C to find the factorial of a number using recursion
//WAP in C to find the factorial of a number using recursion. #include<stdio.h>
int fact(int); void main()
{
int num,res;
printf("Enter a number:"); scanf("%d",&num);
//find the factorial using recursion res=fact(num); printf("factorial=%d",res); getch();
}
int fact(num)
{
if(num==0)
return 1;

else
}
return num*fact(num-1);


Output: Enter a number:5 factorial=120


	Problems / questions  related to the above class         :     5 Minutes

	Attendance      :  5 Minutes 

	Reference        :  

	Lab taken by   : 






	Programme- Diploma Engineering 
Semester-1st& 2nd (Common) 
Course Code-Th 1b (Practical)
Periods/week-04 periods per week
Duration of period-55mins

	
Lab taken by   : 
Mr. Sabyasachi Sarangi
	
Lab Class No. 58
Week No.

	Course Name : Computer Application Practical


	Topic-  C- Programming 


	Essential Prerequisites : One computer set 


	Intended Learning Outcome expected- After the completion of this topic, students  will be able to
“Write a program in C to find the sum of Fibonacci series by using function “


AIM OF THE EXPERIMENT: WAP in C to find the sum of Fibonacci series by using function

//WAP in C to find the sum of fibonacci series using function. #include<stdio.h>
int sumcalc(int*, int); void main()
{
int fib[40],num,sum;
printf("how many fibonacci number do you want?"); scanf("%d",&num);
sum=sumcalc(fib,num);
printf("Assume first fibonacci number is 1"); printf("\nsum of fibonacci series is:%d",sum); getch();
}
int sumcalc(int *fibo, int num)
{
int sum,i; if(num<=0)
return 0; fibo[0]=0; fibo[1]=1;
sum=fibo[0]+fibo[1]; for(i=2;i<=num;i++)
{
fibo[i]=fibo[i-1]+fibo[i-2]; sum=sum+fibo[i];
}
return sum;
}


Output :[image: https://lh4.googleusercontent.com/gNSxHlk5Hv2ZXhHAi3Ba12v5SrSKt4yEm1nSWRUXTadXMhJgjggfPOC85JyYhFjIEOrdCzVrhyUwOwWqcFO_1gEsJ_70NbO_P_iMDlovAMGmzFaAxCDKRJysOtqWOSaUQ9DN2uqC]

	
Problems / questions  related to the above class         :     5 Minutes

	Attendance      :  5 Minutes 

	Reference        :  

	Lab taken by   : 





	Programme- Diploma Engineering 
Semester-1st& 2nd (Common) 
Course Code-Th 1b (Practical)
Periods/week-04 periods per week
Duration of period-55mins

	
Lab taken by   : 
Mr. Sabyasachi Sarangi
	
Lab Class No. 59
Week No.

	Course Name : Computer Application Practical


	Topic- C- PROGRAMMING

	Essential Prerequisites : One computer set 


	Intended Learning Outcome expected- After the completion of this topic, students  will be able to
“Write a program in C to accept a number from keyboard , and print it in reverse using function” 




AIM OF THE EXPERIMENT: WAP in C to accept a number from keyboard , and print it in reverse using function
//WAP in C to accept a number from KB, and print it in reverse using function. #include<stdio.h>
void reverse(int no)
{
int rem,rev=0; while(no>0)
{
rem=no%10; rev=rev*10+rem; no=no/10;
}
printf("rev=%d",rev);
}
void main()
{
int no;
printf("Enter a number:"); scanf("%d",&no); reverse(no);
getch();
}

Output: Enter a number:123 rev= 321

	Problems / questions  related to the above class         :     5 Minutes

	Attendance      :  5 Minutes 

	Reference        :  

	Lab taken by   : 





	Programme- Diploma Engineering 
Semester-1st& 2nd (Common) 
Course Code-Th 1b (Practical)
Periods/week-04 periods per week
Duration of period-55mins

	
Lab taken by   : 
Mr. Sabyasachi Sarangi
	
Lab Class No. 60
Week No.

	Course Name : Computer Application Practical


	Topic- C – PROGRAMMING


	Essential Prerequisites : 
	Intended Learning Outcome expected- After the completion of this topic, students  will be able to
“Write a program in C to accept a number from keyboard , and print it in reverse using function” 





AIM OF THE EXPERIMENT: WAP in C to accept a number from keyboard , and print it in reverse using function
//WAP in C to accept a number from KB, and print it in reverse using function. #include<stdio.h>
void reverse(int no)
{
int rem,rev=0; while(no>0)
{
rem=no%10; rev=rev*10+rem; no=no/10;
}
printf("rev=%d",rev);
}
void main()
{
int no;
printf("Enter a number:"); scanf("%d",&no); reverse(no);
getch();
}

Output: Enter a number:123 rev= 321
	Problems / questions  related to the above class         :     5 Minutes

	Attendance      :  5 Minutes 

	Reference        :  

	Lab taken by   : 
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Step 2. Switch ON the CPU
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This opens a new presentation. Everything is set up and you just need to insert images and text in the
various placeholders

||
Eq

Figure 11: PowerPoint is ready for you to insert your own pictures and text.

3
H
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When you start up PowerPoint, the program is ready with a new blank presentation. The presentation
contains a single empty "slide". In PowerPoint, we do not work with "pages” as in Word, but with "slides".

Click to add title

TCicktoadd subtitie |

Figure 2: The screen elements.
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If you have followed the exercises until now, you have a presentation with one slide. It is a "title slide”
which forms the presentation front. In that slide we now need a tile and a subtitle

The boxes for the ttles are already there, so all you have to do is click on the boxes and enter the desired
text. You can always write the same as I did in Figure 18

[&=

o -
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Content Objects can be recognised because it says "Click here to add text” at the top. In the middle of
them there are six small icons.

Figure 23: The icons in the Content Objects.

When you click to enter text, the text will stand as a bulleted list with the "bullets” to the left of each line
of text. It can be changed afterwards if you do not want bullets.

The functions of the icons are:
Table, where you can insert a table with a number of rows and columns as you choose.

Excel where you get to choose between the many charts offered by the Excel spreadsheet program.
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The spreadsheet contains some sample data to help you to insert your own data in the right places.You can
see that the chart data is surrounded by a thin blue frame. It shows exactly what data is included in the
chart. If you write something in more rows or colums, the frame will adjust by itself. You can also
manually resize the frame by clicking on it in the lower right comer, holding the mouse button and
dragging it o the size you want. In this way you can get as many series and categories as you want

o

- a
mmmm g

Slide with Excel Chart 1

Figure 32: The screen is divided in a "presentation part” and a "spreadsheet part’".
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5.2 Order of the Slides
“This is what to do if you decide that the order of your slides should be different

In standard view you can change the order by moving the thumbnails on the left side of the screen, but if
‘you have many slides in the presentation the "Slide Sorter” view is easier to work with.

1. Select the View Tab in the Ribbon.
2. Click the Slide Sorter button
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In the Animations Tab you can choose transition effects (see Figure 24). There are more effects than are
immediately visible. You will find the rest by clicking on the arrows to the right of the buttons.

[ e S

E I3 el TSR

e
Figure 62: Here you can choose the transitions to the siide.
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6. Playing the Slide Show

Now we are up and running! Everything is ready and we can start the show. If you have chosen that
everything should just run automatically in an endless loop, you only have to press the ESC key when you
do not want to look at it anymore. If not there are some things you must manage when running the
presentation.

You advance your slides by clicking the left mouse button. But you might need to go back to a previous
slide because someone suddenly asks a question about something you went through 10 minutes ago. Here
is where the keyboard comes in handy.

‘To advance using the keyboard, use the following keys:

‘Space bar (handy because it is easy to hit)
Down arrow

Right arrow

PageDown (eller PgDn)

ENTER

To get to the previous slides use the following keys:

+ Upamow
+ Leftarrow
« PagelUp (eller PgUp)

In addition, you can go to the lastslide by pressing the END key and the first slide by pressing the HOME
key.

When you move the mouse, four small discrete icons appear at the bottom left of the screen. Two of them
‘you probably will not need, since their function is only forward and backward.
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Step 4. After a few seconds of that, you will see
the main page. The main page will look like this

after the computer is switched ON

Computer Showing main page
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‘A Local Area Network (LAN)

Wide Area Network (WAN): A WAN typically consists of two or more LANs. The computers are farther
apart and are linked by telephone lines, dedicated telephone lines, or radio waves. The internet is the
largest Wide Area Network (WAN) in existence,

A Wide Area Network (WAN)
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Router

Arouter is a hardware device that allows you to connect several
computers and other devices to a single intemet connection, which s
known as a home network. Many fouters are wireless, allowing you to
easily create a wireless network.

You don't necessarily need to buy a router to connect to the internet.
Its possible to connect your computer directly to your modem using an
Ethernet cable. Also, many modems now include a built-in router, so

you have the option of creating a network without having to buy more
hardware.

Most routers also act as a hardware firewall, which helps prevent
people from gaining access to your computer through the internet.

A wireless router
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Modem

A DSL modem

Once you have your computer, you really don't need much additional hardware
o connectto the intemet. The primary piece of hardware you need is a
modem

The type of intemet access you choose will determine what type of modem you
need. Dial-up access uses a telephone modem, DSL service uses a DSL
modem, cable access uses a cable modem, and satellte service uses a
satellite adapter. Your ISP may give you a modem (often for a fee) when you
sign a contract with them, which helps to ensure that you have the right kind of
‘modem. However, if you would prefer to shop for a better or cheaper modem,
then you can choose to buy one separately.
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Network Card

‘A network card

A network card is a piece of hardware that allows computers to
communicate over a computer network. Most newer computers have a
network card buit into the motherboard, so it probably is not something
you will need to purchase. The network card willeither have an
Ethernet port, a wireless connection, or both

If you have a laptop with a wireless connection, you can access the
internet at any place that offers a Wi-Fi connection. Many restaurants,
coffee shops, bookstores, hotels and other businesses offer free
Wi-Fi. In addition, many cities provide free Wi-Fi in public areas such
as parks and downtown areas.
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grace.ellington@gmail.com
—_—

username at email
provider

bhubbard522@yahoo.com
————

Usemames often contain numbers and shortened

versions of a name to prevent duplicates

will@gcflearnfree.org
———
Some businesses and organizations
provide emails with their own website

domain

‘Sample Email Addresses
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About Email Providers

In the past, people usually received an email account from the same companies that provided their internet
access. For example, if AOL provided your interet connection, you'd have an AOL email address. While this is
stiltrue for some people, today it's increasingly common to use a free web-based email service, also known

as webmail. Anyone can use these services, no matter who provides their internet access:

Webmail Providers

Today, the top three webmail providers are Yahoo!, Microsoft's
Hotmail, and Google's Gmail. These providers are popular

because they allow you to access your email account from
anywhere with an intemnet connection. You can also access YaHOO! maiL
‘webmail on your mobile devices.

2> Visit the links below to compare the features of the three “ H B
.Hotmail

top webmail providers;

i Gmail

« Gmail Features

Other Email Providers Top Webmail Providers

Many people also have an email address hosted by their
company, school, or organization. These email addresses are usually for professional purposes. For
example, the people who work for this website have email addresses that end with @gcflearnfree.org. If you
are a part of an organization that hosts your email they l show you how to access it
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Introduction

Now Me:

No matter what email service you choose, you'l need to lear how o interact
with an email interface, including the inbox, the Message pane and the
Compose pane. Depending on the email provider, the interface may look and
feel different, but they all function in essentially the same way.

In this lesson, we'l talk about using an email interface to send and receive
messages. We'll also discuss various terms, actions and features that are
commonly used when working with email
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Email Sender

Gmail - ° W o PN =h=
m javier.flores838 Upcoming Charity Event 1neh2
Linkedin Updates Linkedin Network Updates 101812
Inbox (79)
Starred quran kareem Very Important - Plzase lis! 10312
Wportant Linkedin Updates Linkedin Network Updates g2
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Hotmail
Inbox (1)

4 Folders
Junkc

Compose the
message and click
Send when ready

Flagged
Photos.
Office doce

Shipping updtes

4 Messenger
Loacing.

Horme
Contacts

Calendsr

e ot Spellchece Rchtct

Enter the recipient's email
address, type the subject
and include attachments

judyriverasg@hotmail.com -

[_Ta] | gncedingtonggmailcom #x ’
Subject | Tea and Duke Garders
serts § Avachments 53 Offce docs ] Photos = (30 FromBing + @ Emoticons

Tea and Duke Gardens (1 of : uploaded) Edit album details Preview slic|
res Bloorn,
Donex

Hello Grace!

1 wanted to invite you for an aftemoon tea at the Duke Washington ad then

a strol at the gardans afterward. The summer colors should be lovly.

1 can make a reservation for 2 pm for any of the following dates:

* saturday, May 28
* Sunday, June §
* Saturday, June 11

Use these commands to
format text, if desired

Just let me know which date you would prefer.
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Step 3. Turn on the monitor and watch the screen carefully.
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Shutting down the Computer
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Step 1. Go to the Start button and click it from the mouse.
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Step 2. You will see a menu like this.

Step 3. Click Shut Down

> AllPrograms

[Search programs and fles
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Restarting from the Windows desktop

In any version of Windows, navigate to the desktop and press + on
your keyboard. Doing so brings up a menu similar to the one displayed
below. Click the down arrow for the drop-down list, select Restart, and
click OK.

£7 Windows 7 Professional

e
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Step 5. Select Shut down by clicking it.

Step 6. Then, click OK.

Shut Down Windons.

£7 Windows 7

et do you want the computer o do?

loses o open programs, shuts down Windows, and ten tums.
offyour computer.

o) [ame e ]
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Step 4. A box like this will appear.
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Power initialization

- 1

BIOS startup
— 1
POST
Video and device BIOS
- 1T
System check
— 1
Plug-and-play check
— 1T
Summary display
R

Boot device found

R
Operating system running

Fig: Booting Process of an Operating System
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Power Supply Exhaust Fan: This fan is usually found at the back of the power
supply and is used to cool the power supply and take the hot air out of the case
and power supply unit.

Rear (exhaust)
1 12¢m fan for CPUNGA cooling

Top (exhaust)
2 14/12cm fan or

1x UCTA18AIUCTVQ18A

Front (intake)
2 12cmfans for HDD cooling
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The following figure shows the CPU liquid Cooling system.

Liquid CPU Cooling System
www.mintywhite.com

Radiator
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Types of memory
i

|E'AE|

ROM

[sRAM]

[DRAM] [PrROM]

EPROM

[EEPROM]

ication of computer memory
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DRAM SRAM
1. Constructed of tiny capacitors | L.Constructed of circuits similar to D
that leak electricity. flip-flops.
2.Requires a recharge everyfew | 2.Holds its contents as long as power
milliseconds to maintain its data.  |is available.
3.Inexpensive. 3.Expensive.
4. Slower than SRAM. 4. Faster than DRAM.
5. Can store many bits per chip. 5. Can not store many bits per chip.
6. Uses less power. 6.Uses more power.
7.Generates less heat. 7.Generates more heat.
8. Used for main memory. 8. Used for cache.

Difference between SRAM and DRAM
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RAM ROM

1. Temporary Storage. 1. Permanent storage.

2. Store data in MBs. 2. Store data in GBs.

3. Volatil 3. Non-volatile.

4.Used in normal operations. 4. Used for startup process of
computer.

5. Writing data is faster. 5. Writing data is slower.

Difference between RAM and ROM
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01,20/2016 Favorites
03,07,2021 inittk ini
01,20/2016 Links
081172021 Music
03,07,2021 Nox_share
03,07,2021 nuuid.ini
06,30,2021 Pictures
01,20/2016 Saved Ganes
09,26,2016 Searches
03,07,2021 53 useruid.ini
H1724/2021 Uideos

63/07,2021 unlogs
462 bytes
17 Dirs>  77,331,423,232 hytes free

:\Users\dell>date
he current date is: Wed 04/20,2022
fEnter the new date: (mm-dd-yy>

\Users\dell>
:\Users\dell>tine

he current time is: 20:16:26.07
fEnter the new time

:\Users\dell>
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Uolune in drive C has no label.
Uolune Serial Number is CCES-BFDE

Directory of Ci\DHONI

4/20/2022 88:39 PN <DIR>
4/20/2622 88:39 PN <DIR>

0 File(s> 0 hytes

2 Dirds> 77.863,991,296 hytes free
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The user clicks the mouse to initiate some action. Depending on which button is pressed,
we call it a right click or a left click. The figure below shows a left click. When the mouse
button is clicked twice in quick succession we call it a double click. For example, on the
desktop, double clicking the left mouse button on a file or folder usually opens it. A single
right click on the desktop will open a menu with options for the desktop's settings.

ey &

-
-—
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A mouse is an input device that can be used to control the computer. It is a small object
that can roll along a hard, flat surface. Its name is derived from its shape, which looks a bit

like a mouse, its connecting wire that one can imagine to be the mouse's tail, and the fact
that one must make it scurry along a surface.

MOUSE PAD

MOUSEj

A pointer or a cursor indicates the current spot of activity on the screen. The mouse pointer
is an indicator on the screen that moves when the mouse moves. A common way in which

we communicate with the computer is by moving the mouse pointer to the reauired spot

and clicking to perform an action. Some k sommonly Z 10use point {T)
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Windows 10 Control Panel

[ Control Panel - o x

PN

> Control Panel > v|®] | Search Control ..
Adjust your computer's settings Viewby: Category

System and Security

Review your computer's status

Save backup copies of your files with
File History
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D-ROM into your CD tr

ou should see is the

one shown in the following illustration.

etup is inspecting your computer’s hardware configuration
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If the previous screen does not appear. reboot your machine and open up
the BIOS. You need to make the system boot to the CD-ROM first. The
following screen is one of several different BIOSes you could have on
your system. You need to navigate to a screen that allows you to change
the Boot Order. This is where you tell it to boot off of the CD-ROM.
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Now your system should boot off of the CD-ROM. After a period of time
(typically 30-45 seconds). the following screen appears. Because we are

doing an initial install. you only need to press Enter to continue.
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You should now see two partitions. Verify that the new 2047 partition is highlighted and
press Enter.

Windous XP Professional Setup
The following list shous the existing partitions and
unpartitioned space on this computer.
Use the UP and DOUN ARROW keys to select an item in the list.
= To set up Windows ¥P on the selected item. press ENTER.
= To create a partition in the unpartitioned space. press C.

= To delete the selected partition, press D.

8190 MB Disk @ at 1d © on bus B on atapi [MBR1
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Regional and Language Options
You can customize Windows XP for diferent regions and languages.

@9, Regional and Language Options allow you to change the way numbers, dates,
¢ curtencies and the time are displayed. You can also add support for addtional
languages, and change your location selting.

The Standards and formals sefting s set to Englsh [United States), and the
location is set to United States.

To change these settings, click Custorize. ustomize,

Test Input Languages allow you to enter textin many diferent languages, using
a variety of input methods and devices.

Vo dafaul tasd b Isnesison sid mathod i LIS kisbasl ok
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Micosor:

“w Windows

Personalize Your Software
Setup uses the information you provide about yourself to personalize your Windows

XP software.

Type your full name and the name of your company or organization.

Name: [\whome

Organization: [Computer Useq
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Figure 4: The Office Button
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Figure 5: When you click on the Office Button, this menu opens.
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How to start a computer

We should follow these steps carefuly for starting the computer:

Step 1. Insert the UPS plug into the socket and turn on the main power supply.

UPS switch ON
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The following llustrates A_ it Cocolo Doce

. Goto cell F1.

. Type 3.

. Press Enter. Excel moves down one cell.

. Type 3.

. Press Enter. Excel moves down one cell.

. Type 3.

. Press Enter. Excel moves down one cell to cell F4.

. Choose the Home tab.

. Click the AutoSum button ' in the Editing group. Exce
through F3 and enters a formula in cell F4.
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2.8 Copy, Cutand Paste
You can copy or cut data from one area of a worksheet to another.

1. Select cells D9 to D12
2 Choose the Home tab
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Set the Page Layout (Margins)

e == [

1. Choose the Page Layout tab.
2. Click Margins in the Page Setup group. A menu appears.
3. Click Wide. Excel sets your margins to the Wide settings.

Set the Page Orientation
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1. Choose the Page Layout tab.
2. Click Orientation in the Page Setup group. A menu appears.
3. Click Landscape. Excel sets your page orientation to landscape.

Set the Paper Size

1. Choose the Page Layout tab.
2. Click Size in the Page Setup group. A menu appears.
3. Click the paper size you are using. Excel sets your page size.
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3 Products Region1 Region2 Region3

4 Dolls 2478 2640 2388

5 Trucks 031 A 2%

6 Puzles 118 2 0%

7 Total 627 7535 1973
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After you have created the worksheet, you are ready to create your chart.
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4.1 Createa Chart

Toy Sales

2795

To create the column chart shown above, start by creating the worksheet below
exactly as shown.
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Move a Chart to a Chart Sheet

LB

1. Click your chart. The Chart Tools become available.

2. Choose the Design tab.

3. Click the Move Chart button in the Location group. The
box appears.
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Apply a Chart Layout

1. Click your chart. The Chart Tools become available.

2. Choose the Design tab.

3. Click the Quick Layout button in the Chart Layout group. A list of chart layouts
appears.

4. Click Layout 5. Excel applies the layout to your chart.




